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摘要 

都市河流是海洋塑膠微粒的重要來源之一，我們想要探討都市河流特性對塑膠微粒分佈

的影響，並了解環境中不同飲用水源的塑膠微粒含量。本研究選取屏東市萬年溪和殺蛇溪共7

個採樣點，以及飲用水源和瓶裝水各6種，利用尼羅紅染色塑膠微粒，再以螢光顯微鏡觀察計

算各水樣的平均螢光強度進行比較。結果顯示尼羅紅能附著塑膠製品並在顯微鏡下呈現螢光。

都市河流部份，經生態工法整治、保留較多曲折水道的萬年溪河段，較能降低河水中的塑膠

微粒含量。飲用水源部份，從淨水場到家中的過程會導致塑膠微粒增加，而一般濾水設備能

有效降低塑膠微粒含量。瓶裝水部份，包裝材質和過濾與否會影響水中塑膠微粒含量。 

壹、 研究動機 

塑膠微粒（尺寸小於5mm且一般為大於0.0001mm）除了影響環境生物，更可能透過食物

鏈影響人類的健康。對於塑膠微粒污染的研究，長期以來著重在其匯集地－海洋，但近期對

於淡水和陸域環境的關注日益增加，因為有80%的塑膠污染來自陸地，而且河流是塑膠微粒

匯集至海洋的主要路徑之一。 

都市河流流經人口密集的都市區域，其特點在於坡度平緩、河道系統複雜，以及擔負污

水處理功能，除了一般的污染物質之外，理應也匯聚了不少塑膠微粒，但有研究指出河流中

的塑膠微粒含量與人口密度或與污水處理廠的距離沒有直接相關，反而是與流速的改變有關。

近年來台灣河流的復育整治多採取生態工法，與過去「三面光」、「截彎取直」的河道整治思

維相異，影響了河流的流速，是否也影響河流的塑膠微粒含量，值得進一步探討。 

屏東市位於屏東平原，市區內有萬年溪和殺蛇溪流貫，這兩條都市河流匯流成牛稠溪，

最後流入高屏溪。早期因經濟發展，畜牧、工業、家庭廢水大量排入萬年溪造成污染，自2008

年開始進行萬年溪整治計畫，利用萬年溪周邊綠地作為淨化水質之溼地，以太陽能及重力將

水體導入公園綠地內（例如千禧公園、萬年公園），並設置多層次之過濾淨化水池及曲折水

道，增加污水之曝氣量以及和淨化植栽接觸之面積與時間，設置石籠護岸承受河川的沖蝕、

堆積作用，創造多孔隙、多樣性的生物棲息空間。 

而殺蛇溪同樣受畜牧、家庭、工業廢水污染，但缺乏計劃性整治，河道部份仍採取傳統
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工法。殺蛇溪流經的屏東工業區長期以來因沒有設立污水處理廠，污水都直接排放至殺蛇溪。

這兩條整治思維相異的都市河流，不論在河道曲折程度、邊坡類型，或是淨化工法上都大相

逕庭，因此我們期望透過這兩條都市河流的塑膠微粒分佈，進一步了解河流環境對塑膠微粒

分佈的影響。 

此外，屏東平原地下水豐沛，過去屏東市民眾長期以地下水或山泉水作為飲用水源，近

年來因自來水接管率增加和環境污染疑慮，飲用水源除了地下水之外，還包括自來水和過濾

設備處理後的水，因此我們也想了解這些生活環境的飲用水源和市售瓶裝水的塑膠微粒含量

情形。 

 

圖1. 屏東市周圍溪流，其中萬年溪與殺蛇溪流經人口較密集區域 
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萬年溪主要流經商業區、公園用地和住宅區，殺蛇溪主要流經住宅區和工業區。 

  

圖3.萬年溪沿岸生態工法（千禧公園） 圖4.殺蛇溪沿岸傳統工法 

 

貳、文獻探討 

一、塑膠微粒的定義 

目前科學上沒有塑膠微粒的標準定義，但依據各界（如美國國家海洋暨大氣總署）普遍

之定義，所謂塑膠微粒（microplastics）為尺寸小於 5 毫米（大小約為一粒黑芝麻）且一般為

大於 0.0001 毫米，而其中若尺寸小於 1 微米（1 微米等於 0.001 毫米），通常被稱為奈米塑膠

微粒（nanoplastics）。 

按照來源的不同，塑膠微粒可以分為初級塑膠及次級塑膠。前者為於工業製造時，體積

就很小的塑膠纖維或顆粒；後者則為從塑膠袋、塑膠瓶或輪胎磨損顆粒等各種塑膠產品中，

因化學或物理老化或降解而產生，常見型態有顆粒、碎片、薄片與纖維等。 

常見的塑膠微粒材質有六種，分別為：聚丙烯（PP）、聚乙烯（PE）、聚對苯二甲酸乙二

醇酯（PET）、聚苯乙烯（PS）、聚氯乙烯（PVC），以及俗稱尼龍的聚醯胺纖維（Nylon / PA）。

塑膠產品會因特定性能要求而加入添加劑，例如目前最受關注的 DEHP 塑化劑與雙酚 A。因

此，除了塑膠微粒本身材質，也必須考量添加化合物從微粒中滲濾到水或周圍環境中所帶來

的影響。另一方面，PP、PE、PS 材質的塑膠微粒容易吸附並釋放其他有毒化學物質，像是多

氯聯苯、多芳香烴、戴奧辛等持久性有機汙染物。 
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二、塑膠微粒如何產生 

根據國際自然保護聯盟（International Union for Conservation of Nature）在 2017 年所發表的

報告，塑膠微粒來源多半與我們的日常用品息息相關，主要包括：(1)於製造、加工、運輸和

回收過程中，顆粒可能會掉到環境中；(2)於工業上或家庭中清洗合成衣物時因為纖維的磨損

和脫落而產生的初級塑膠；(3)於駕駛車輛時輪胎磨損而產生；(4)車輛的行駛造成道路標記的

風化和磨損而產生；(5)因施工、維護和移除船用塗料而造成的風化；(6)個人護理產品（如：

洗面乳、化妝品）因添加塑料微珠（microbeads）被使用後沖入污水系統；(7)城市灰塵（如：

合成鞋底等物體、人造草皮等基礎設施等）因風化、磨損而產生。 

三、日常生活中如何接觸塑膠微粒? 

人體接觸或吸收塑膠微粒的途徑主要分為三種：飲食或飲水攝入、呼吸吸入以及使用化

妝品時皮膚接觸。 

(1)飲食或飲水攝入 

   食用體內含有塑膠微粒的魚、蝦、貝類等海鮮，飲用受塑膠微粒汙染的水源。另外，

世界衛生組織於 2019 年關於塑膠微粒於飲用水的報告指出，地表逕流沖刷以及污水

排放被認為是塑膠微粒進入水源中的兩種主要管道；瓶裝水的塑膠瓶蓋和瓶身也可能

為飲用水中塑膠微粒的來源。 

(2)呼吸吸入 

飄散在空氣中的塑膠微粒（如：來自於合成衣物纖維、城市塵埃等），可以經由口鼻

進入呼吸系統中，其他如建築材料、垃圾焚燒、交通工具可能也會暴露到塑膠微粒。 

(3)皮膚接觸 

微塑料顆粒可能會用於化妝品，例如:去角質劑和牙膏等，我們的皮膚會與塑膠微粒

接觸。這些添加於化妝品中之塑膠顆粒的尺寸通常都很大，雖然很少會穿透皮膚進入

體內，但是仍須對塑膠微粒進行更多研究來評估風險。 

四、可檢測塑膠微粒的方法介紹 

今年 4 月行政院環保局公告水中微型塑膠檢測方法-熱觸法實施，但是此水樣若含高濁度

之懸浮微粒、動植物碎片及藻類等，易造成濾膜孔隙阻塞或遮蔽濾膜上之微型塑膠而影響檢
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測。而檢測塑膠微粒還有另外二種方法，分別為螢光染色法及拉曼光譜法。根據 Thomas Maes

等人的研究論文（A rapid-screening approach to detect and quantify microplastics based on fluorescent 

tagging with Nile Red）尼羅紅有親油性，可以溶於乙醇，並可將塑膠微粒染色，且在波長下

(495–570nm) 能被激發至特定光波段，這是螢光染色法。若能將激發至特定光波段的螢光加

以方析，進行塑膠定性，這是拉曼光譜法。 

檢測塑膠微粒方法比較如下: 

 熱觸法 螢光染色法 拉曼光譜法 

作法 

在顯微鏡下以高溫

之針尖碰觸樣品，若

為塑膠則可產生熔

化或是捲曲現象 

樣品以尼羅紅染劑

染色後，於螢光顯微

鏡下觀察 

顯微拉曼光譜分析

儀進行塑膠定性分

析 

優缺點比較 

優點:簡易 

缺點:耗時，且需要

小心操作，塑膠必須

較大可清楚看見 

優點:快速，適合大

規模篩測 

缺點:可能有部分塑

膠材質無法染色，且

無法分析塑膠成分。 

優點:鑑定塑膠成分 

缺點:過細纖維可能

因為雷射光斑打在

濾紙產生光譜干擾 

五、塑膠微粒對於人體是否有健康影響? 

塑膠微粒對於人類健康是否會產生的影響，目前仍欠缺精準的研究以及足夠的數據。至

於塑膠微粒裡的毒性化學物，依據世界衛生組織 2019 年及歐洲食品安全局 2016 年報告中指

出，依照目前有限的相關毒理學數據，也很難證實或評估喝入或食入塑膠微粒對於人類的健

康危害，雖然無法證實，若能提早避免攝入，也是保持健康的良方。 

六、何謂鹽溶? 

[鹽溶]（Salting in）是一種物理現象。當一溶液中同時含有蛋白質和離子化合物，提高離子化

合物的濃度可提高該蛋白質的溶解度。造成這種現象的原因是當蛋白質鹽溶液濃度提高時，

因蛋白質的電荷會吸引與它相反電荷的離子，從而將蛋白質保護起來。然而，這個現象通常

只發生在離子濃度低的情況下，離子濃度高時可觀察到相反的現象，稱其為鹽析（Salting out），

亦即離子濃度越高，蛋白質溶解度即降低。 
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參、 研究目的 

為探討都市河流及生活環境飲用水源的塑膠微粒分佈情形，研究目的分述如下： 

一、探討尼羅紅染劑對塑膠微粒的染色效果 

二、探討屏東市內都市河流的塑膠微粒分佈 

三、探討屏東市內飲用水源的塑膠微粒含量 

四、探討不同品牌瓶裝水的塑膠微粒含量 

 

肆、 研究設備及器材 

一、實驗設備儀器: 

微量電子秤、震盪器、抽氣用pump、離心機、倒立顯微鏡(附NIS-Elements AR 軟體)、相

機。 

二、實驗器材 

微量滴管(pipette)、打孔器、無菌濾上杯、濾紙、試管、玻片、電動吸水器、玻璃滴管、

不銹鋼桶、童軍繩、玻璃瓶數個 

三、實驗藥品 

尼羅紅粉末、乙醇 

四、實驗樣本 

殺蛇溪溪水、萬年溪溪水、柔珠洗面乳、矽藻土、溪水沉澱物、衣服棉絮、自來水、地

下水、麥飯石過濾水、軟水、瓶裝水。 
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伍、 研究方法與結果 

一、探討尼羅紅染劑對塑膠微粒的染色效果 

 (一)、研究方法 

1. 製作尼羅紅染劑:先用微量天平秤取尼羅紅粉末 0.003g，用pipette取乙醇3ml加入，

並放置於震盪器上方，以 60rpm 震盪 30 分鐘，讓溶質溶劑充分混合，溶劑達到

1mg/ml 的濃度，再將調配好的尼羅紅染劑冰入冰箱保存。 

2. 將柔珠洗面乳加入 RO 水，再用離心機將柔珠分離出來，取其柔珠。 

3. 分別取矽藻土、衣物棉絮、柔珠及溪水中的沉澱物加入尼羅紅染劑，進行封片觀

察。 

4. 將濾紙加上尼羅紅染劑，進行封片，看看尼羅紅是否可以將濾紙染色? 

(二)研究結果 

 

   圖 5. 製作玻片樣本。 

   

在倒立顯微鏡（一般光源）

下可看見柔珠，非常圓一顆

顆 

柔珠+尼羅紅染劑在倒立顯微

鏡（螢光）下，會發出亮光，

證明尼羅紅染劑可染柔珠。 

濾紙+尼羅紅染劑在倒立顯微鏡

（螢光）下，無法發出亮光，所

以濾紙不會被尼羅紅染劑染色 

圖 6.柔珠可被尼羅紅染劑染色，濾紙不會被尼羅紅染劑染色。 
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倒立顯微鏡 

(一般光源) 

   
說明: 溪水+粗粒碎屑物+尼羅紅染劑，我們在倒立顯微鏡(一般光源)下看到碎屑物一點一點 

倒立顯微鏡

(螢光) 

   
說明: 溪水+粗粒碎屑物+尼羅紅染劑，我們在倒立顯微鏡(一般光源下)看到碎屑物一點一點，但它們

在倒立顯微鏡(螢光)下卻無法發光，只有溪水中的塑膠微粒發光。 

圖 7.尼羅紅染劑無法染沉澱物，但可染污水中的塑膠微粒。 

倒立顯微鏡

(一般光源) 

       
說明: 矽藻土(是一種生物化學沉積岩，由矽藻的細胞壁沉積而成，具親水性)+尼羅紅染劑，我們在倒立

顯微鏡一般光源下看到的是細胞壁 

倒立顯微鏡

(螢光) 

   
說明:矽藻土+尼羅紅染劑，因細胞壁不是脂質，所以尼羅紅不能將它染色，故在倒立顯微鏡螢光下呈現

黑色 

圖 8. 尼羅紅染劑不會染矽藻土(非脂性)，證明尼羅紅有親脂性 
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二、探討屏東市內都市河流的塑膠微粒分佈 

     探討屏東溪流流經工業區、商業區塑膠微粒螢光強度的差別及微型塑膠數目濃度 

     (一)、研究方法 

 1 溪水採樣:採樣前利用大量自來水沖洗玻璃瓶及採樣器，採樣過程穿著純棉質之衣

服以免污染。採樣時以不銹鋼桶為採樣器，進行採樣時記錄採樣地點、座標等。

採樣方法參考「河川、湖泊及水庫水質採樣通則」進行採樣。我們採溪水水面

上層水，距離水面下不超過 20 公分，多次取樣。採樣後樣品妥善放置以室溫保

存。 

[表一] 採樣地點、座標 

 

倒立顯微鏡

(一般光源) 

   
說明:衣服棉絮(成分棉質、尼龍等)+尼羅紅染劑，在倒立顯微鏡一般光源下黑色一絲一絲是棉絮 

倒立顯微鏡

(螢光) 

   
說明: 衣服棉絮+尼羅紅染劑，有被染色的是尼龍-聚醯胺纖維，在倒立顯微鏡螢光下很亮，而呈現黑色   

不透光是棉纖維。 

圖 9.尼羅紅染劑會染塑膠微粒，但不會染棉纖維 

河流名稱 採樣點代號 座標 描述 

萬年溪 

W1（廣東橋） 22°40'51.3"N 120°30'04.6"E 河水流入千禧公園前 

W2（勝利橋） 22°40'37.0"N 120°29'56.3"E 河水流出千禧公園後 

W3（獅子橋） 22°39'57.3"N 120°29'09.3"E 河水流入萬年公園前 

W4（建國橋） 22°39'52.6"N 120°29'00.4"E 河水流出萬年公園後 

殺蛇溪 

S1（東匯橋） 22°39'55.0"N 120°30'06.4"E 河水流入屏東工業區前 

S2（清流橋） 22°39'39.0"N 120°29'59.8"E 河水流經屏東工業區 

S3（劉厝橋） 22°40'51.3"N 120°30'04.6"E 河水流出屏東工業區後 
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圖10. 本研究採樣點。萬年溪採樣點為W1～W4，殺蛇溪採樣點為S1～S3。 

 

 

 

 

         圖 11. 殺蛇溪採樣點（S1～S3），虛線區域為屏東工業區。  
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      圖 12. 萬年溪採樣點（W1～W4），虛線區域為千禧公園和萬年公園 

 

2. 塑膠微粒的採取:將各採集點的溪水，各 500ml 分別置入玻璃瓶中，加入 2.925 克的食鹽，

攪拌靜置 10 分鐘後，利用鹽溶性質，再取玻璃瓶中的上方水 25ml 加入 25ul 的尼羅紅染

劑於試管中。將試管放置於震盪器上方，以 60rpm 震盪 30 分鐘染色。再將 5C 孔徑 1µm

的濾紙裁切為 2cm *2cm 大小，將濾紙放置無菌濾上杯，利用真空泵提供壓力差，將其

溶液分別過濾。 

3. 將過濾完的濾紙用鑷子夾起晾乾後，正面朝下放置於載玻片上，取一片蓋玻片，讓蓋玻

片與載玻片成 45 度角慢慢蓋上，進行封片。 

4. 將玻片放置螢光顯微鏡下觀察，找尋濾紙中心點拍攝並記錄螢光強度，再取上下左右等

距拍攝並記錄。利用 ImageJ 軟體將其螢光強度量化，並分析比較。 

 

[ImageJ 軟體]使用說明: 

1. 開啟檔案 Filt> Open ，直線工具先設定比例尺 Analyze > Set Scale 

2. 再將圖像轉為 8-bit（Image>Type>8-bit）  

3. 圖像調整彩色闕值 Image> Adjust>Threshold 

4. 選擇闕值算法 Image> Adjust> Auto Threshold，勾選 Try all 

5. 設定需要測量的參數 Analyze>Set Measurements，確認勾選 Mean gray value 和 Limit to 

threshold，點擊 OK。 
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6. 檢測 Analyze> Measure，點擊 Measure 後彈出檢測結果。 

7. 平均螢光強度(Mean) = 該區域螢光強度總和(IntDen) / 該區域面積(Area) 

   Mean: Mean gray value       IntDen: Integrated Density（螢光強度總和） 

  單位是 Arbitrary Units（AU） 

(二)、研究結果 

圖 13.殺蛇溪採樣點（S1～S3）在倒立顯微鏡(螢光)下的照片，激發波長為 495nm，發射波長為 520nm 

(A: 濾紙中心點往上 B: 濾紙中心點往下 C: 濾紙-中心點 D: 濾紙中心點往右  E: 濾紙中心點往左) 

 

 

 

 

 
[表 2] 屏東市殺蛇溪採樣點（S1～S3）平均螢光強度 (AU) 

            濾紙位置 

採樣點 
A B C D E 平均 

S1 東匯橋 14.99 18.94 19.85 18.76 17.86 18.08 

S2-清流橋 21.15 18.55 18.98 18.66 18.45 19.16 

S3-劉厝橋 21.26 20.3 21.19 21.37 20.37 20.9 

    

S1

東

匯

橋 

A B C D E 

     

S2

清

流

橋 

     

S3

劉

厝

橋 
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圖 14. 屏東市萬年溪採樣點（W1～W4）在倒立顯微鏡(螢光)下的照片，激發波長為 495nm，

發射波長為 520nm (A: 濾紙中心點往上 B: 濾紙中心點往下 C: 濾紙-中心點 D: 濾紙中心點

往右  E: 濾紙中心點往左) 

 

 

[表 3] 屏東市萬年溪採樣點（W1～W4）平均螢光強度（AU） 

           濾紙位置 

採樣點 
A B C D E 平均 

W1-廣東橋 42.73 92.79 65.14 93.5 52.34 69.3 

W2-勝利橋 15.75 19.85 18.7 20.05 15.96 18.06 

W3-獅子橋 19.02 15.52 19.78 18.91 24.36 19.52 

W4-建國橋 19.34 18.66 18.28 18.55 17.9 18.54 

     

W1

廣

東

橋 

A B C D E 

     

W2

勝

利

橋 

     

W3

獅

子

橋 

     

W4

建

國

橋 
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圖 15. 比較屏東市殺蛇溪、萬年溪採樣點的平均螢光強度 

 

1.以殺蛇溪樣本來看: 

 數據顯示流經工業區（S1→S3）後，螢光強度上升，塑膠微粒變多。 

2.以萬年溪樣本來看: 

(1)數據顯示，流經千禧公園（W1→W2）後螢光強度下降，塑膠微粒變少，流經萬年公園

（W3→W4）後，螢光強度下降，塑膠微粒變少。其中流經千禧公園的數值下降較多。 

(2)W2→W3 之間流經商業區（仍有生態工法改善河道），以數據來看有增加，但相較殺蛇

溪流經工業區（S1→S3）後，萬年溪的變化量仍較小。 

3.綜整 

  比較兩條溪流，W1 的數值高於 S1，顯示萬年溪在 W1 之前的塑膠微粒污染，比殺蛇溪 S1

前還嚴重。 

 

三、探討屏東市內飲用水源的塑膠微粒含量 

     (一)、研究方法 

1.平日用水的採樣:採樣前利用大量自來水沖洗玻璃瓶及採樣器，採樣過程穿著純棉

69.30 
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質之衣服以免污染。採樣後樣品妥善放置以室溫保存。 

2.自來水淨水場的採樣:先與自來水淨水場負責單位聯繫，並約好時間拿沖洗後的玻

璃瓶去現場採水。 

3.塑膠微粒的採取:將地下水、家中自來水、自來水淨化場、麥飯石過濾水、軟水，

用滴管為玻璃的電動吸取機吸取各 25ml 置入試管中，再加入 25ul 的尼羅紅染劑，

並放置於震盪器上方，以 60rpm 震盪 30 分鐘染色。再將 5C 孔徑 1µm 的濾紙裁切

為 2cm *2cm 大小，將濾紙放置無菌濾上杯，利用真空泵提供壓力差，將其溶液分

別過濾。 

4.將過濾完的濾紙用鑷子夾起晾乾後，正面朝下放置於載玻片上，取一片蓋玻片，

讓蓋玻片與載玻片成 45 度角慢慢蓋上，進行封片。 

5.將玻片放置螢光顯微鏡下觀察，找尋濾紙中心點拍攝並記錄螢光強度，再取上下

左右等距拍攝並記錄。利用 ImageJ 軟體將其螢光強度量化，並分析比較。 

    (二)、研究結果 
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 [表 4] 屏東市內飲用水源平均螢光強度（AU） 

 

 

 

 

 

 

 

 

 

ㄉ 

     

 

ㄊ 

     

圖 16. 屏東市內飲用水源，在倒立顯微鏡(螢光)下的照片，激發波長為 495nm，發射波長為

520nm (A: 濾紙中心點往上 B: 濾紙中心點往下 C: 濾紙-中心點 D: 濾紙中心點往右  E: 濾

紙中心點往左 ㄅ: 家中自來水 ㄆ: 麥飯石過濾水 ㄇ: 地下水 ㄈ: RO 逆滲透水 ㄉ: 自來水

淨水場  ㄊ:軟水) 

        濾紙位置 

採樣點 
A B C D E 平均 

家中自來水 34.68 67.29 75.63 46.3 74.2 59.62 

自來水淨水場 28.56 29.82 32.52 25.17 31.44 29.5 

地下水 18.97 13.7 21.86 23.3 29.92 21.55 

軟水 19.21 33.37 16.73 18.86 18.9 21.41 

RO 逆滲透水 18.99 22.69 21.81 22.3 18.93 20.94 

麥飯石過濾水 18.41 16.64 18.71 16.81 20.27 18.17 



18 
 

 

 

圖 17. 比較屏東市內飲用水源平均螢光強度 

 

1. 比較溪水及飲用水源: 

因為日常食用水體單純，不是戶外溪流那麼複雜，所以我們沒有使用鹽溶。 

2. 以自來水來看: 

   取樣點不同，螢光強度也不同，家中自來水有管線污染，而自來水淨水場則無，故自來水

淨水場平均螢光強度較家中自來水小。 

3. 綜整 

   自來水由水源地送到家戶需要經過很多流程，然後才能到達消費者家中。 取水→導水→

淨水→送(配)水。送（配）水：原水經過淨水程序及消毒後已適合飲用稱為自來水，將自

來水以管線配送至家戶的過程稱為送(配)水。水從離開淨水場到家中水龍頭流出，其實還

需要經過管線以及家中的儲水設施，在這過程中確實有可能被汙染。若我們家中有安裝濾

水器，則可大幅降低塑膠微粒。 

 

四、探討不同品牌瓶裝水的塑膠微粒含量 

 (一)、研究方法 
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 取水方法比照飲用水源的方法。 

 (二)、研究結果 

       

      

ㄅ 

A B C D E 

     

 

ㄆ 

     

 

ㄇ 

     

 

ㄈ 

     

 

ㄉ 

     

 

ㄊ 

     

圖 18. 探討不同品牌瓶裝水，在倒立顯微鏡(螢光)下的照片，，激發波長為 495nm，發射波長

為 520nm (A: 濾紙中心點往上 B: 濾紙中心點往下 C: 濾紙-中心點 D: 濾紙中心點往右  E: 

濾紙中心點往左 ㄅ: 冰河水 ㄆ: 甘泉水 ㄇ: 山泉水 ㄈ: 純水 ㄉ: 離子水  ㄊ:竹炭水) 
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[表 5] 不同品牌瓶裝水平均螢光強度（AU） 

       濾紙位置 

採樣點 
A B C D E 平均 

冰河水 105.63 108.89 110.04 97.01 110.19 106.35 

甘泉水 86.85 81.44 81.94 83.64 88.49 84.47 

山泉水 28.07 29.22 30.05 33.13 27.78 29.65 

純水 30 32.98 30.5 23.01 23.16 27.93 

離子水 26.68 18.9 23.64 29.13 31.55 25.98 

竹炭水 33.6 20.98 29.7 17.28 18.81 24.07 

 

 

 

   [表 6] 不同品牌瓶裝水水體區別                     

 

                                             圖 19. 不同品牌瓶裝水平均螢光強度 

1. 比較冰河水和山泉水平均螢光度: 

冰河水和山泉水兩者都是外國進口，但冰河水其瓶身較山泉水薄，加上可能因為運送關係、

天候等外在因素，造成平均螢光強度比山泉水高。 

2. 以地下水體來看: 

甘泉水及竹炭水雖然都是地下水體，但如果有多一道過濾，平均螢光強度也有差別。 
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陸、 討論 

一、探討尼羅紅染劑對塑膠微粒的染色效果 

塑膠為石化工業產物，具有親脂性，我們利用親脂性螢光染劑-尼羅紅，對塑膠微粒進行

染色，快速檢測成分中是否含有塑膠微粒。以螢光偵測具有較高的辨識度，塑膠微粒種類會

影響染色後之螢光強度。根據尼羅紅染劑會因溶劑之極性改變顏色的特性，發現塑膠微粒表

面之極性，也會影響染色後所呈現的顏色，故用此方法作為基本塑膠微粒之初步判別。 

二、探討屏東市內都市河流的塑膠微粒分佈 

由平均螢光強度來看，萬年溪流經千禧公園（W1→W2）時下降最多，代表在此段河水

中塑膠微粒有明顯減少，根據文獻河水在速度下降時，塑膠微粒會沈積下來，由千禧公園的

河段來看（如圖 20），有 A、B、C 三處的河道轉折點，當河流在轉彎的時候，流水常急速的

衝向河道的外側，內側的流速則比較緩慢，加上河道兩旁的生態工法，除了創造生態棲地外，

也創造了流速減緩的微區域，因此我們推測這些地形的影響，會導致河流流速變慢，塑膠微

粒沈降較多。此外，由於塑膠微粒會進入食物鏈，因此兩旁生物也有可能吸附部份塑膠微粒，

這些推論需要在後續實驗克服技巧上的困難（從淤泥和生物體檢測塑膠微粒含量），才能加以

證實。 

萬年溪流經萬年公園（W3→W4）時，雖然同樣都是生態淨水的工程，但是萬年公園是

利用太陽能將萬年溪水抽至公園高處，順流而下經過沈澱曝氣等處理，相對淨水量和減速的

效果不如千禧公園，加上萬年公園今年才完工，兩旁生物量也不如千禧公園，所以推測造成

塑膠微量減量的效果不如千禧公園。在千禧公園和萬年公園之間的河段（W2→W3），雖然流

經人口眾多的商業區，長度也較長，但塑膠微粒增加的量不多，我們推測除了生態工法和 D、

E、F（如圖 20. 21）三處轉折的影響之外，屏東市污水接管率增加（如圖 22），減少家庭污水

排放入萬年溪，應該也是原因之一。 

雖然適合的都市河流生態工法可以減少河水中的塑膠微粒含量，但是如果真如推測，塑

膠微粒是從河水轉移到河底污泥和河流生物，可能又會有另一種隱憂，值得後續深入研究。 

與萬年溪相較，殺蛇溪採樣點 S1 前流經區域人口數較少，因此在 S1 測得塑膠微粒含量不高，
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但是在 S3 測得的數值卻有增加，這代表流經工業區時仍有塑膠微粒排入。以 google 地圖粗估

採樣點的距離，W2→W3 約 2.13 公里，S1→S3 約 2.08 公里，兩者相差不遠，W2→W3 的平均

螢光強度增加 1.46AU，S1→S3 卻增加了 2.98AU，代表單位長度內殺蛇溪的塑膠微粒增加量

較萬年溪高。根據新聞報導，過去殺蛇溪的工業廢水是直接排流至殺蛇溪，雖然目前已經開

始施作污水管、截流井和污水處理廠等工程，但仍未完工，所以我們推測此段殺蛇溪內的塑

膠微粒來源應是工業區內的廠家，其中園區內塑膠製品製造業有 10 家占第 4 位（經濟部工業

局，2020），是否為塑膠微粒來源，仍須進一步探討。 

   

            圖 20.萬年溪河道                          圖 21. 萬年溪河道 
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圖 22. 屏東縣高屏溪流域（屏東市）污水下水道系統建設圖 

 

三、探討屏東市內飲用水源的塑膠微粒含量 

我們家中的自來水管路已經非常老舊且年久未清理，根據自來水公司提供老舊自來水管

線汰換率平均僅 0.66%。而 2017 年管線逾齡最嚴重的地區在高雄、屏東，逾齡水管是否會孳

生細菌而產生過多的塑膠微粒?自來水從離開淨水場到家中水龍頭流出，其實還需要經過管線
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以及家中的儲水設施，在這過程中確實有可能被汙染。自來水管線老舊、破裂，造成大量鏽

蝕物溶於水中、滲漏進泥沙，甚至家裡的水塔長期沒有清潔、消毒，都會汙染水源。這些都

是可能影響塑膠微粒增多的原因。 

地下水我們是採用家中剛好有一水管直接連通地底下的地下水，水量豐沛，水管因為常

常使用，水管內部也較沒有青苔產生，清潔度良好，也無塑膠管線的干擾。 

軟水則是水質軟化處理係採用樹脂離子交換濾心為素材，以樹脂中所含有的鈉離子（使

用一段時間必須以鹽水來清洗，就是讓樹脂再吸附足夠的鈉離子 ）來交換水中鈣、鎂離子，

如此方式雖水中的鈣、鎂離子減少，但卻增多了水中的鈉離子，這樣的處理方式，就人體而

言是把人體所需的鈣、鎂離子降低了（如同 RO 逆滲透水及蒸餾水等）。 

而 RO 逆滲透水又稱「純水」，顧名思義就是非常純淨的水。這種利用薄膜製程處理產

製的純水，已將水中的病原菌、雜質、礦物質、微量元素、無機鹽類…移除，可作為純淨無

虞的飲用水。但近來有醫學專家陸續指出，由於純水中缺乏維持人體機能運作所需的礦物質

及微量元素，因此不建議長期飲用。但我們取得點是在住家，將飲水機拆開看，發現內部的

管線都是塑膠製成，難免也會有塑膠微粒的汙染。 

麥飯石就是斑狀安山岩或安山斑岩，是具有離子交換能力，能吸附水中所含的重金屬、

雜質，並過濾水中水質甘甜好喝。麥飯石濾心最主要補充在 RO 逆滲透過程中被過濾掉的鈣、

鎂、鈉、鉀等離子。而實驗出平均螢光亮度依序分別為: 家中自來水>自來水淨水場>地下水>

軟水>RO 逆滲透水>麥飯石過濾水。 

 

四、探討不同品牌瓶裝水的塑膠微粒含量 

有很多文獻都已經證實(Microplastic in Bottled Natural Mineral Water - Literature Review and 

Considerations on Exposure and Risk Assessment.)瓶裝水內含有塑膠微粒。而「Orb Media」於 2018

年公布的最新報告，瓶裝水高達 93%的樣本中，含有塑膠微粒，其研究人員在每公升瓶裝水

中，平均驗出 325 個塑膠微粒，至於塑膠微粒的成分，則聚丙烯(PP)佔百分之 54，其他還有

尼龍(16%)、聚乙烯(10%)等，其中最讓研究人員注意的是，瓶裝水中居然有工業用潤滑劑(4%)。

當時就有推論這些塑膠碎片的來源可能大部分來自於瓶子、瓶蓋，以及自動裝瓶的生產過程。
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這和我們做出來的瓶裝水有較高的螢光強度是相符的。冰河水具有超高塑膠微粒，跟運送過

程、保存方式也有相關，而瓶裝水平均螢光數值從大到小分別為 冰河水> 甘泉水> 山泉水> 

純水> 離子水> 竹炭水。以上瓶裝水的平均螢光強度皆大於地下水，地下水整體而言是否可

能較瓶裝水安全，這也是我們可以更深入探討的研究話題。 

 

圖 23. 屏東市自來水淨水場 

 

柒、結論 

一、探討尼羅紅染劑對塑膠微粒的染色效果 

尼羅紅粉末加水和柔珠、濾紙皆無法產生螢光，但和乙醇可以則可以產生螢光。我們利

用尼羅紅此特性，將尼羅紅+乙醇製作成尼羅紅染劑，讓它能去依附塑膠表面。而塑膠微

粒會影響染色後之螢光強度，若螢光強度越強，代表塑膠微粒越多。 

二、探討屏東市內都市河流的塑膠微粒分佈 

屏東市內的河流歷經整治，不管是萬年溪的生態工法還是殺蛇溪的傳統工法，皆能有效

降低溪水中塑膠微粒的含量。但是否是塑膠微粒從河水轉移至河底汙泥和河流生物，這

是值得繼續深入研究。而工業區要做的汙水管、截流井和汙水處理廠等工程，是否能防

止塑膠微粒的產生和工業區的塑膠微粒來源是工廠排放還是空氣汙染、家庭廢水的排放?

仍需進一步探討。 

三、探討屏東市內飲用水源的塑膠微粒含量 

南部自來水屬於硬水，區別是水中礦物質(鈣、鎂等)的多寡，水中鈣、鎂含量在 120 毫克

以下的稱為「軟水」，反之則為「硬水」。軟水比較甘甜，而硬水則較為苦澀。自來水管
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線老舊、破裂，造成大量鏽蝕物溶於水中、滲漏進泥沙，甚至家裡的水塔長期沒有清潔、

消毒，都會汙染水源。就算淨水廠給我們乾淨的自來水，之後也有可能會汙染，唯一能

避免將汙染物吃下肚，解決方式就是安裝過濾系統。而自來水經由管線到家中的過濾系

統，不管是何種過濾裝置，皆能大大降低平均螢光強度。 

四、探討不同品牌瓶裝水的塑膠微粒含量 

看到我們這次做的實驗，那冰河水、甘泉水螢光強度之亮，真是令人害怕。而著名期刊<

環境科學與技術>刊載一篇題目為(Human Consumption of Microplastics)的研究報告，指出

喝瓶裝水會大幅增加攝入的塑膠微粒。如果一年只喝瓶裝水，會比喝自來水多攝入 9 萬

顆塑膠微粒。所以專家建議減少喝瓶裝水。現實生活塑膠微粒無所不在，我們是無可避

免將塑膠微粒吃下肚，為何專家會更關注瓶裝水的污染問題呢?因為瓶裝水每年消費量巨

大，塑膠瓶若要在環境中完全分解需要 450 年，而一旦進入水中，塑膠無法完全降解，

會分解成極小的塑膠微粒。若將瓶裝水喝完繼續裝水喝，其時這些一次性塑膠瓶所使用

材質是 PET，若長時間放置或暴露在高溫下，塑膠微粒還是會釋放進水中。所以若想安

全飲水，使用水壺來裝水較為安全。 

 

捌、 參考資料 

 

1. FAO (Food and Agriculture Organization of the United Nations) (2017). Lusher, A., Hollman, P., 

Mendoza-Hill, J. Microplastics in fisheries and aquaculture: status of knowledge on their occurrence 

and implications for aquatic organisms and food safety. Fisheries and Aquaculture Technical paper, 

615. from http://www.fao.org/3/a-i7677e.pdf 

2. Thomas, M., Rebecca, J., Nikolaus, W., Karsten, H., & Andrew, G. M. (2017). A rapid-screening 

approach to detect and quantify microplastics based on fluorescent tagging with Nile Red. Scientific 

Reports, 7, 44501. 

3. Elena, H., Elke, K. F. (2019). Nile red staining in microplastic analysis-proposal for a reliable and 

http://www.fao.org/3/a-i7677e.pdf


27 
 

fast identification approach for large microplastics. Environ Monit Assess, 191, 612. 

4. Gabriel, E. C., Matthew, I. G., Richard, C. T., and Joseph, A. C. (2017) Thompson, Joseph A. 

Christie-Oleza. Lost, but Found with Nile Red: A Novel Method for Detecting and Quantifying Small 

Microplastics (1 mm to 20 μm) in Environmental Samples. Environ Sci Technol, 51, 

13641–13648. 

5. Darena, S., Christophe, G., Hans-Ulrich, H., Peter, F. (2018) Analysis of microplastics in water by 

micro-raman spectroscopy: release of plastic particles from different packaging into mineral water. 

Water Research, 129, 154-162. 

6. Frank, W., Roland, F. (2018). Microplastic in bottled natural mineral water - literature review and 

considerations on exposure and risk assessment. Food Addit Contam Part A Chem Anal Control Expo 

Risk Assess, 35, 2482-2492. 

7. Jingyi, L., Huihui, L., J. Paul, C. (2019). Microplastics in freshwater systems: A review on 

occurrence, environmental effects, and methods for microplastics detection. Water Research, 137, 

362-374. 

8. Kieran, D. C., Garth, A. C., Hailey, L. D., John, F. D., Francis, J., and Sarah, E. D. (2019). Human 

consumption of microplastics. Environ Sci Technol, 53, 7068–7074. 

9. 萬 年 溪 復 育 整 治 · 臺 灣 河 川 復 育 網 (TRRN) 河 川 復 育 案 例 · 取 自 

file:///C:/Users/USER/Downloads/148c61bf1b0000007ce3%20(6).pdf 

10. Joana, C. P., Vanessa, R., João, T.V. M., João, P. da. C., Armando, C. D., Teresa, R. S. ( 2019). A 

new approach for routine quantification of microplastics using Nile Red and automated software 

(MP-VAT). Science of The Total Environment, 690, 1277-1283. 

11. 國內自來水、海水、沙灘砂礫與貝類中微型塑膠之現況調查 (2018 年 9 月 25 日)·行政院

環境保護署環檢所·取自 https://www.cienve.org.tw/x/file/epaper/108_1/tech3.pdf 

12. Ocean microplastics: 'Lost 99%' of tiny pollutants could now be identified with new method. from 

https://www.independent.co.uk/environment/ocean-microplastics-pollution-method-dye-identify-calcu

late-scientist-tiny-pollutants-a8074126.html?fbclid=IwAR3gHLmWVRSZ2WOKT-ha0P0sojMA2sN

file:///C:/Users/USER/Downloads/148c61bf1b0000007ce3%20(6).pdf
https://www.cienve.org.tw/x/file/epaper/108_1/tech3.pdf


28 
 

Bba_vTBmUCb64n0sn6fowtJcVHDM 

13. 蔡美瑛 (2017 年 5 月 22 日) ·環境教育專題報導（一）：「塑膠柔珠」是「幫手」還是「殺

手」？·取自 https://scitechvista.nat.gov.tw/c/sf9c.htm 

14. 蔡美瑛 (2017 年 5 月 19 日)·環境教育專題報導（二）：海洋生態與人類健康的隱形殺手

──塑膠柔珠·取自 https://scitechvista.nat.gov.tw/c/sf95.htm 

15. 李 讃 虔 (2018 年 5 月 24 日 ) ·  塑 膠 微 粒 —— 微 小 的 生 態 殺 手  · 取 自

https://scitechvista.nat.gov.tw/c/sg3f.htm 

16. 環境檢驗所(2020 年 1 月 4 日) 水中微型塑膠檢測方法-熱觸法 (NIEA M909.00C) [公告] ·

取自 https://www.epa.gov.tw/niea/6BEE72C0B3545B27 

17. 環境檢驗所 (2004 年 12 月 27 日) 河川、湖泊及水庫採樣通則 (NIEA W104.51C) [公告] ·

取自 https://www.epa.gov.tw/niea/7AB3A823E6E36A4B 

18. 108 年度屏東工業區簡介·屏東縣: 屏東工業區服務中心·取自

file:///C:/Users/USER/Downloads/60_%E5%B1%8F%E6%9D%B1%E5%B7%A5%E6%A5%AD%E

5%8D%80.pdf 

 

 

 

 

 

 

 

 

https://scitechvista.nat.gov.tw/c/sf9c.htm
https://scitechvista.nat.gov.tw/c/sf95.htm
https://www.epa.gov.tw/niea/6BEE72C0B3545B27
https://www.epa.gov.tw/niea/7AB3A823E6E36A4B
https://www.moeaidb.gov.tw/ctlr?PRO=document.rwdDocTitleView&id=2622&t=1
file:///C:/Users/USER/Downloads/60_å±�æ�±å·¥æ¥­å��.pdf
file:///C:/Users/USER/Downloads/60_å±�æ�±å·¥æ¥­å��.pdf


作品海報 

【評語】030504  

研究主題清楚且聚焦，方法具有可行性。對社會有產生影響潛

力。有控制變因的嘗試與探討。表達清楚，具邏輯性。 

此作品探討塑膠微粒對環境的影響，並且追溯塑膠微粒在都市

河流中的分布情形以及在飲用水中的含量，也針對不同塑膠微粒對

環境的影響進行探討，結果十分有意義，是環境保育課題的良好作

品，在生活層面上，也有相當實用的價值。 

實驗方法(利用尼羅紅染劑對塑膠微粒染色，進而能判斷塑膠

微粒量)具挑戰性。需要針對尼羅紅的偵測效果作定量校正；瓶裝

水的微塑膠含量也要有定量的結果，會增高作品的價值。 

D:\NSF\中小科展_60 屆\排版\030504-評語 



都市河流是海洋塑膠微粒的重要來源之一，我們想要探討都市河流
特性對塑膠微粒分佈的影響，進而探求環境中不同飲用水源及生活
周遭瓶裝水的塑膠微粒含量。

將各採集點溪水，各500ml分別置入玻
璃瓶中，加入2.925克的食鹽，攪拌靜
置10分鐘後，利用鹽溶性質，再取玻璃
瓶中的上方水 25ml加入25ul的尼羅紅染
劑於試管中。將試管放置於震盪器上

方，以60rpm震盪30分鐘染色。再將5C
孔徑1μm的濾紙裁切為2cm*2cm大小，
將濾紙放置無菌濾上杯，利用真空泵提

供壓力差，將其溶液分別過濾。

尼羅紅有親油性，可以溶於乙醇，並可將塑膠微粒染色，且

在波長下(495–570nm)能被激發至特定光波段，這是螢光染
色法。若能將激發至特定光波段的螢光加以方析，進行塑膠

定性，這是拉曼光譜法。今年4月行政院環保局公告水中微
型塑膠檢測方法-熱觸法實施，但是此水樣若含高濁度之懸浮
微粒、動植物碎片及藻類等，易造成濾膜孔隙阻塞或遮蔽濾

膜上之微型塑膠而影響檢測。

地下水、家中自來水、自來水淨化場、麥飯石

過濾水、軟水，用滴管為玻璃的電動吸取機吸

取各 25ml 置入試管中，再加入 25ul 的尼羅紅
染劑，並放置於震盪器上方，以60rpm震盪 
30 分鐘染色。再將 5C 孔徑 1μm 的濾紙裁切
為 2cm *2cm 大小，將濾紙放置無菌濾上杯，
利用真空泵提供壓力差，將其溶液分別過濾。

1.溪水部份 2.日常飲用水源部份

比照日常飲用水源取水部份

3.瓶裝水部份

壹 研究動機

肆 研究結果

貳 研究目的

參 設備器材與實驗設計

前置作業

進行實驗

檢測塑膠微粒方法比較如下:

塑膠微粒的採取

1.製作尼羅紅染劑：先用微量天平秤取尼羅紅粉末
0.003g，用 pipette取乙醇3ml加入，並放置於震
盪器上方，以60rpm震盪30分鐘，讓溶質溶劑充
分混合，溶劑達到1mg/ml的濃度，再將調配好的
尼羅紅染劑冰入冰箱保存。

2.先確定尼羅紅是否可以染濾紙(實驗一之一)?
3.尼羅紅是否可以染塑膠微粒? (實驗一之一到四)?

一、實驗器材及藥品

二、實驗設計與流程

三、檢測塑膠微粒的方法介紹

Sigma 尼羅紅粉末 微量電子秤 微量滴管(pipette) Nikon ECLIPSE Ti 抽氣用 pump 震盪器 離心機 無菌濾上杯

親脂性高，可吸附於
塑膠微粒上

圖片

說明

名稱

秤量尼羅紅粉 吸取適量的溶劑 觀察濾紙上的塑膠
微粒

抽真空
讓尼羅紅和乙醇均勻
混合在實驗用水中

將柔珠洗面乳中的
柔珠分離出來

放置濾紙，並在
濾紙下抽真空

塑膠微粒採取

非鹽溶

鹽溶

日常用水

瓶裝水

溪水

熱觸法

作
法

優
缺
點
比
較

螢光染色法 拉曼光譜法

在顯微鏡下以高溫之

針尖碰觸樣品，若為

塑膠則可產生熔化或

是捲曲現象。

優點：簡易。

缺點：耗時，且需要

小心操作，塑膠必須

較大可清楚看見。

樣品以尼羅紅染劑染

色後，於螢光顯微鏡

下觀察。

優點：快速，適合大

規模篩測。

缺點：可能有部分塑

膠材質無法染色，且

無法分析塑膠成分。

用顯微拉曼光譜分析

儀進行塑膠定性分析

優點：鑑定塑膠成

分。

缺點：過細纖維可能

因為雷射光斑打在濾

紙產生光譜干擾。

一、探討尼羅紅染劑對塑膠微粒的染色效果
二、探討屏東市內都市河流的塑膠微粒分佈
三、探討屏東市內飲用水源的塑膠微粒含量
四、探討不同品牌瓶裝水的塑膠微粒含量

將過濾完的濾紙用鑷子夾起晾乾後，正面朝下放置於載玻片上，
取一片蓋玻片，讓蓋玻片與載玻片成45度角慢慢蓋上，進行封
片。將玻片放置螢光顯微鏡下觀察，找尋濾紙中心點拍攝並記錄
螢光強度，再取上下左右等距拍攝並記錄。利用 ImageJ 軟體將其
螢光強度量化，並分析比較。

實驗一：探討尼羅紅染劑對塑膠微粒的染色效果

在倒立顯微鏡(一般

光源 ) 下 可看見柔

珠，非常圓一顆顆

濾紙+尼羅紅染劑在倒

立顯微鏡(螢光)下，無

法發出亮光，所以濾紙

不會被尼羅紅染劑染色

柔珠+尼羅紅染劑在

倒立顯微鏡 (螢光 )

下，會發出亮光,證明

尼羅紅染劑可染柔珠

說明: 溪水+粗粒碎屑物+尼羅紅染劑，我們在倒立顯微鏡(一般光源)下看到碎屑物
一點一點

倒立

顯微鏡

(一般光源)

倒立

顯微鏡

(螢光)

說明:溪水+粗粒碎屑物+尼羅紅染劑，我們在倒立顯微鏡(一般光源下)看到碎屑物一
點一點，但它們在倒立顯微鏡(螢光)下卻無法發光，只有溪水中的塑膠微粒發光。
尼羅紅染劑無法染沉澱物，但可染污水中的塑膠微粒。

實驗一之二結果： 尼羅紅可染溪水中的塑膠微粒，但無法染沉澱物。

實驗一之一： 尼羅紅是否可以染濾紙?
尼羅紅是否可以染塑膠微粒(柔珠)?

實驗一之二：尼羅紅是否可以染溪水及
粗粒碎屑物?

實驗一之一結果：柔珠可被尼羅紅染劑染色，濾紙不會被尼羅紅染劑染色。



萬年溪採樣點為 W1~W4，
殺蛇溪採樣點為 S1~S3。

萬年溪採樣點(W1~W4)，
綠色區域分別為千禧公園和萬年公園

紅色區域為商業區

萬年溪沿岸生態工法
(千禧公園)

萬年溪沿岸生態工法
(千禧公園內)

萬年溪沿岸生態工法
(萬年公園外)

萬年溪生態工法
(萬年公園外)

生態滯洪池
(萬年公園內)

萬年溪沿岸生態工法
(萬年公園外)

1.W1→W2：萬年溪流經千禧公園後，平均螢光強度下降，塑膠微粒含量減少。千禧公園採自然工法，低密度開發，保留了原始綠地，園區內以草溝取代水泥溝取，所
有降雨直接滲透入地底，多餘排往萬年溪,雨水可供地面植物，也增加地下水源注入。

2.W2→W3：萬年溪流經商業區後，平均螢光強度上升，塑膠微粒含量增加。
3.W3→W4：萬年溪流經萬年公園後，平均螢光強度下降，塑膠微粒含量減少。萬年公園部份河段以砌石護岸生態工法，利用太陽能將溪水抽取至公園內，經過沉沙、
疊瀑及礫間水生植栽淨化水道進入景觀生態池。
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水質 採樣處 

家中自來水 家中水管內的自來水 

自來水淨水場 屏東營運所自來水 

地下水 家中直接從地下抽取上來的水 

軟水 家中裝置軟水過濾系統 

RO 逆滲透水 家中裝置 RO 逆滲透水 

麥飯石過濾水 外面販售麥飯石過濾水(投幣式) 

 

萬年溪樣本來看

殺蛇溪樣本來看

比較兩條溪流

1.W1的數值大於S1，顯示萬年溪在W1之前的塑膠微粒污染，比殺
蛇溪S1前還嚴重。 

2.W2→W3之間流經商業區，以數據來看萬年溪塑膠微粒有增加，
但相較殺蛇溪流經工業區S1→S3後，萬年溪的變化量仍較小。

1.S1→S3：殺蛇溪流經工業區後，平均螢光強度上升，塑膠微粒含量增加。殺蛇溪流經工業區、舊糖廠(已廢棄)及舊紙廠(已廢棄)，雖然沒有汙水處理廠，但是興建縣民
公園，將綠地全面提升共有 20 公頃，並打造水岸綠廊生態地景。

殺蛇溪水泥護岸 (東匯橋) 殺蛇溪取水(工業區內，清流橋右側)

殺蛇溪取水(清流橋左側，工業區內) 工業區內大排水口 (清流橋右側)

實驗二:探討屏東市內都市河流的塑膠微粒分佈

實驗三:探討屏東市內飲用水源的塑膠微粒含量

倒立

顯微鏡

(一般光源)

倒立

顯微鏡

(螢光)

說明：矽藻土+尼羅紅染劑，因細胞壁不是脂質,所以尼羅紅不能將它染色，故在倒立顯微鏡

螢光下呈現黑色。尼羅紅染劑不會染矽藻土(非脂性)，證明尼羅紅有親脂性

說明：矽藻土(是一種生物化學沉積岩，由矽藻的細胞壁沉積而成，具親水性)+尼羅紅染

劑，我們在倒立顯微鏡一般光源下看到的是細胞壁

倒立

顯微鏡

(一般光源)

倒立

顯微鏡

(螢光)

說明：衣服材質(棉纖維及尼龍)+尼羅紅染劑，有被染色的是尼龍-聚醯胺纖維，在倒立顯微

鏡螢光下很亮，而呈現黑色不透光是棉纖維。

說明：衣服材質(棉纖維及尼龍)+尼羅紅染劑，在倒立顯微鏡一般光源下黑色一絲一絲是棉

纖維，說明尼羅紅染劑會染塑膠微粒，但不會染棉纖維

實驗一之三結果：尼羅紅不會染矽藻土(非脂性)，證明尼羅紅有親脂性。

河流名稱 採樣點代號

W1(廣東橋)
W2(勝利橋)
W3(獅子橋)
W4(建國橋)
S1(東匯橋)
S2(清流橋)
S3(劉厝橋)

22°40'51.3"N 120°30'04.6"E
22°40'37.0"N 120°29'56.3"E
22°39'57.3"N 120°29'09.3"E
22°39'52.6"N 120°29'00.4"E
22°39'55.0"N 120°30'06.4"E
22°39'39.0"N 120°29'59.8"E
22°40'51.3"N 120°30'04.6"E

河水流入千禧公園前
河水流出千禧公園後

河水流入萬年公園前

河水流出萬年公園後
河水流入屏東工業區前

河水流經屏東工業區

河水流出屏東工業區後

座標 描述

萬年溪

殺蛇溪

實驗一之三：尼羅紅是否可以染矽藻土? 實驗一之四：尼羅紅是否可以染衣服材質?

實驗一之四結果：尼羅紅不會染棉纖維，所以在螢光顯微鏡下呈現黑色，
而有被染色的是尼龍 (PA)。

殺蛇溪採樣點(S1~S3)，
紅色圈選區域為屏東工業區。



萬年溪河道

興建汙水下水道系統

屏東縣高屏溪流域(屏東市)

污水下水道系統建設圖

陸 實驗結論

柒 參考資料

參

伍 研究討論

塑膠為石化工業產物，我們利用親脂性螢光染劑-尼羅紅，對塑膠微粒進行染色，在螢光顯微鏡上用特定波長下(495–570nm)激發至特定光波段，並能快速檢測
成分中是否含有塑膠微粒。柔珠是塑膠微粒的代表之一，我們用尼羅紅染色，在螢光下會發出亮光，證明尼羅紅可以染塑膠微粒。若單一使用濾紙加上尼羅紅染色，

則無法在螢光顯微鏡下發出亮光，證明濾紙無法被尼羅紅染色。而溪水加上粗粒碎屑物在尼羅紅染劑下，粗粒碎屑物在螢光下不會發光，而溪水中塑膠微粒則會。衣

服材質有棉纖維及尼龍，加上尼羅紅染劑，則會清楚看到尼龍在螢光顯微鏡下會發亮，棉纖維則無法。此實驗證明尼羅紅染劑對於塑膠微粒有染色效果。

我們家中的自來水管路大多都是 PVC、PE、PA 製品,雖然這些材質都是耐久耐用，但是日久還是會有磨損，且大多
都年久未清理，根據自來水公司提供老舊自來水管線汰換率平均僅0.66%。而 2017 年管線逾齡最嚴重的地區在高雄、屏
東，逾齡水管是否會因破損，而產生過多的塑膠微粒?自來水從離開淨水場到家中水龍頭流出，其實還需要經過管線以及
家中的 儲水設施，在這過程中確實有可能被汙染。

我們做出來的瓶裝水平均螢光強度從大到小分別為：冰河水> 甘泉水> 山泉水> 純水>離子水> 竹炭水。而「Orb 
Media」於 2018 年公布的最新報告，塑膠微粒的成分，聚丙烯佔54%，其他還有尼龍16%、聚乙烯 10%等，其中最讓研
究人員注意的是，瓶裝水中居然有工業用潤滑劑4%。當時就有推論這些塑膠碎片的來源可能大部分來自於瓶子、瓶蓋，
以及自動裝瓶的生產過程。而我們所做 6 種瓶裝水中，山泉水有強調瓶蓋有加厚，瓶身對於要外銷有另外設計。冰河水、
甘泉水相較其他平均螢光強度略高，純水、離子水、竹炭水有多一道過濾或煮沸，會將平均螢光強度降低。

一、尼羅紅染色法可以染塑膠微粒，對於非塑膠微粒部分，例如濾紙、棉纖維，則無法染色。

二、從千禧公園到萬年公園，萬年溪的平均螢光強度在千禧公園前後有明顯下降(從69.3AU降到18.06AU)，推測與地形的影響有關，會導致河流流速變慢，塑膠微
粒沈降較多，所以可以降低平均螢光強度。

三、自來水(從淨水場的29.5AU)經由管線到家中的過濾系統，不管是何種過濾裝置，皆能降低平均螢光強度(降至21AU左右不等)。
四、本實驗中瓶裝水內皆有塑膠微粒(最低24.07 AU)。

1. Thomas, M., Rebecca, J., Nikolaus, W., Karsten, H., & Andrew, G. M. (2017). A rapid-screening approach to detect and quantify microplastics based on 
fluorescent tagging with Nile Red. Scientific Reports, 7, 44501.

2.Jingyi, L., Huihui, L., J. Paul, C. (2019). Microplastics in freshwater systems: A review on occurrence, environmental effects, and methods for microplastics 
detection. Water Research, 137, 362-374.

3.Joana, C. P., Vanessa, R., João, T.V. M., João, P. da. C., Armando, C. D., Teresa, R. S. ( 2019). A new approach for routine quantification of microplastics using Nile 
Red and automated software (MP-VAT). Science of The Total Environment, 690, 1277-1283.

4.國內自來水、海水、沙灘砂礫與貝類中微型塑膠之現況調查(2018年9月25日)·行政院環境保護署環檢所·取自
https://www.cienve.org.tw/x/file/epaper/108_1/tech3.pdf

5.Mintenig, S. M., Löder, M. G. J., Primpke, S., Gerdts, G. (2019). Low numbers of microplastics detected in drinking water from ground water sources. Science of 
the Total Environment, 648, 631–635. 

由平均螢光強度來看，萬年溪流經千禧公園(W1→W2)時下降最多，代表在此段河水中塑膠微粒有明顯減少，根據文獻河水在速度下降時，塑膠微粒會沈積下
來，由千禧公園的河段來看，有 A、B、C 三處的河道轉折點，當河流在轉彎的時候，流水常急速的衝向河道的外側，內側的流速則比較緩慢，加上河道兩旁的生
態工法，除了創造生態棲地外，也創造了流速減緩的微區域，因此我們推

測這些地形的影響，會導致河流流速變慢，塑膠微粒沈降較多。此外，由

於塑膠微粒會進入食物鏈，因此兩旁生物也有可能吸附部份塑膠微粒，這

些推論需要在後續實驗克服技巧上的困難(從淤泥和生物體檢測塑膠微粒含
量)，才能加以證實。
萬年溪流經萬年公園(W3→W4)時，雖然同樣都是生態淨水的工程，

但是萬年公園是利用太陽能將萬年溪水抽至公園高處，順流而下經過沈澱

曝氣等處理，相對淨水量和減速的效果不如千禧公園，加上萬年公園今年

才完工，兩旁生物量也不如千禧公園，所以推測造成塑膠微量減量的效果

不如千禧公園。在千禧公園和萬年公園之間的河段(W2→W3)，雖然流經
人口眾多的商業區，長度也較長，但塑膠微粒增加的量不多，我們推測除

了生態工法和 D、 E、F 三處轉折的影響之外，屏東市污水接管率增加，
減少家庭污水排放入萬年溪，應該也是原因之一。

雖然適合的都市河流生態工法可以減少河水中的塑膠微粒含量，但是如果真如推測，塑膠微粒是從河水轉移到河底污

泥和河流生物，可能又會有另一種隱憂，值得後續深入研究。 與萬年溪相較，殺蛇溪採樣點 S1 前流經區域人口數較少，
因此在S1測得塑膠微粒含量不高，但是在S3測得的數值卻有增加，這代表流經工業區時仍有塑膠微粒排入。以 google 地
圖粗估採樣點的距離，W2→W3 約 2.13 公里，S1→S3 約 2.08 公里，兩者相差不遠，W2→W3的平均螢光強度增加
1.46AU，S1→S3卻增加了2.98AU，代表單位長度內殺蛇溪的塑膠微粒增加量較萬年溪高。根據新聞報導，過去殺蛇溪的
工業廢水是直接排流至殺蛇溪，雖然目前已經開始施作污水管、截流井和污水處理廠等工程，但仍未完工，所以我們推測

此段殺蛇溪內的塑膠微粒來源應是工業區內的廠家，其中園區內塑膠製品製造業有10家占第4位(經濟部工業局，2020)，
是否為塑膠微粒來源，仍須進一步探討。
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不同品牌 水體區別 

冰河水 冰河水體(加拿大) 
甘泉水 地下水體(南投埔里) 
山泉水 山泉水體(阿爾卑斯山) 

純水 山泉水體(宜蘭)105°高溫煮沸、RO逆滲透 

離子水 洋流(台灣海峽)經電透析再蒸發 
竹炭水 地下水體(南投埔里)、經特殊竹炭過濾製程 

以日常飲用水來看

1.家中自來水平均螢光強度遠遠大於自來水淨水場，推測可能跟管線長期沒有清洗有關。自來水系統最常使用的器材，例如直管、彎管、套管、三通管、管塞、制水
閥等，這些都是長期埋設在地底下的設備，沒有清洗也易常汙納垢。 

2.地下水是直接抽取從地表往下滲透的水，遇不透水的岩層時，地下水停止向下滲透，便往上累積形成地下水體，它補注主要依賴雨水，和自來水相比較管線較少，
相對平均螢光強度也較低。

3. 軟水、RO 逆滲透水、麥飯石過濾水，這三種過濾水平均螢光強度相差不大。

1.若比較地下水體，甘泉水及竹炭水都是同地點的水體，若有經過特殊
處理，平均螢光強度較低。

2.若比較由外國進口瓶裝水，加拿大冰河水較法國阿爾卑斯山山泉水平均螢
光強度高。

3.冰河水、甘泉水相較其他平均螢光強度略高，純水、離子水、竹炭水
有多一道過濾或煮沸，會將平均螢光強度降低。

實驗四：探討不同品牌瓶裝水的塑膠微粒含量

實驗一：探討尼羅紅染劑對塑膠微粒的染色效果

實驗二：探討屏東市內都市河流的塑膠微粒分佈

實驗三：探討屏東市內飲用水源的塑膠微粒含量

實驗四：探討不同品牌瓶裝水的塑膠微粒含量
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